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PowerMILL is the leading specialist NC CAM software for 

manufacturing complex shapes typically found in the toolmaking, 

automotive, and aerospace industries. PowerMILL 2010 offers all of the 

original features of PowerMILL 10.0, but with numerous improvements. 

The most significant improvements are described in this document. 

This document is still in the process of being written. This is not a 

complete list of all the improvements. A complete What's New will be 

available in time for the full release of PowerMILL 2010.  

Toolpath preparation 

There are several changes to the Tool axis  dialog (see page 6). 

! There are two new tilt methods on the Collision avoidance tab 

(see page 7) and a new smoothing option. 

! You can now smooth (see page 10) the tool axis different ways.  

! There is a new tab of Orientation vector (see page 14). This 

enables you to control the orientation of the tool which is 

particularly useful when working with an asymmetric machine 

head.

There are several changes to the Tool  dialog (see page 19). 

! There are improvements to Overhang in the Tool Holder tab 

(see page 19). 

Summary of new 
features
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! There is a new tab of Holder Profile (see page 21) which gives a 

fast way of collision checking. 

A new Workplane Editor toolbar (see page 29) replaces the 

Workplane dialog and the workplane options on the Curve Editor
toolbar in previous versions. 

There are additions to the Curve Editor toolbar (see page 47). You can: 

! Edit points; 

! Reverse selected items; 

! Interactively edit simple curves (lines, arcs, circles, and polylines); 

! Input coordinates on the status bar; 

! Use context menus for simple curves. 

There are several improvements to boundaries (see page 72). 

! The calculation of 3D offsetting is run in multiple threads. So it is 

noticeably faster on multi-core machines.  

! You can now create two types of boundary offsets (see page 72). 

! There is a new option on the Silhouette Boundary (see page 73) 

which prevents spikes occurring on near vertical surfaces. 

Models now have a date (see page 74) showing when they were imported 

into the project. 

There are a couple of enhancements to stock models (see page 75). 

! There are additional options to the individual stock model menu. 

! There is a new Stock Models tool state menu (see page 78). 

Toolpath generation 
Many of the existing machining strategies now use the new style 

machining strategy dialog (see page 85). This is a tabbed dialog where the 

pages are selected from the tree in the left hand panel. It is simpler to use 

and provides an easier way to create toolpaths. 

Most of the Area clearance dialogs (see page 86) now use the new 

style strategy dialog. As well as converting them to the new style, there 

has also been a change in the way strategies are displayed in the 

Strategy Selector dialog. Other enhancements include: 

! Avoiding the machining of thin slivers (see page 88) of material 

which appear on the block edge towards the end of machining an 

area.
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! Improved ordering (see page 89). 

There is a new Steep and shallow finishing strategy (see page 90) 

which calculates a shallow boundary, and then creates Constant Z
toolpath in the steep areas of a model and Raster or 3D offset toolpath 

in the shallow areas.  

There is a new Corner finishing strategy (see page 109) which removes 

material left in corners. The toolpath is generated such that the rest 

material is removed in successive stages, using horizontal and vertical 

stitch movements, or along passes. 

Finishing strategies now have the option to allow the tool centre to go 

outside the block (see page 122). 

The Cusp height and Stepover (see page 124) are now linked on 

finishing dialogs.  

There is a new option of Smoothing (see page 126) on the 3D offset 
finishing dialog. 

There are a couple of new options on the Constant Z finishing dialog

(see page 127): 

! Machine down to flats (see page 129). 

! Unsafe segment removal (see page 132). 

You can now view a single Z height (see page 136) of a toolpath. 

Surface finishing has a new option of Degouge tolerance (see page 

142).

You can now create Holes (see page 142) from the Drilling dialog. 

Disc profile finishing now has the option to lift or trace for gouge 

avoidance.

As with PowerMILL 10.0 one of the most important, but least visible 

improvements in PowerMILL 2010 is the use of parallel processing (see 

page 149).  
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Toolpath verification 
There are several enhancements to toolpath verification (see page 150): 

! When verification splits a toolpath, the leads and links are 

preserved where appropriate, on the resulting toolpaths. 

! Simulation can now synchronise the movement of two axes of a 

robot.

! ViewMill now allows a negative overhang. 

! The Table attach point at the top of an .mtd file now defines the 

position of the PowerMILL origin. 

Toolpath output 
This topic has not been fully documented yet. 

User interface 
All the Open and Save dialogs now have customisable buttons (see 

page 152).  

Entities in lists are shown using the same folder structure (see page 153) 

and icons as in the explorer. 

General enhancements 
You can now create a custom toolbar (see page 156) which can contain: 

menu options; toolbar buttons; commands; and macros; that you use 

frequently. 

The user definable values available under Tools > Options are system 

parameters (see page 162).  

There is a new Expression Editing toolbar (see page 163) which 

provides a fast and easy way to create and calculate expressions in 

PowerMILL fields. 

Typed coordinates are now entered in the Status bar (see page 167) 

rather then on the Curve Editor toolbar. 

When you start PowerMILL 2010 for the first time you are asked if you 

want to upgrade to the new tool database (see page 155).  
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Preview
This topic has not been fully documented yet. 
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Tool axis 

There are several changes to the Tool axis  dialog. 

! There are two new tilt methods on the Collision avoidance tab 

(see page 7) and a new smoothing option. 

! You can now smooth (see page 10) the tool axis different ways.  

! You can smooth the Elevation and Azimuth angles 

independently.

! There are new stepped smoothing options which keep the 

elevation or azimuth angle constant without changing the angle 

by more than a specified amount. 

! There is a new tab of Orientation vector (see page 14). This 

enables you to control the orientation of the tool which is 

particularly useful when working with an asymmetric machine 

head.

! To enable the Orientation vector there is an extra option on the 

Definition tab (see page 18). 

! Collision avoidance works better for disc cutters. 

Toolpath preparation 
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Collision avoidance (Tool axis) 

There are several changes to the Collision avoidance tab: 

! There are two new Tilt methods (see page 8). 

! The tilt tool axis options remain unchanged, but have been 

reorganised. The Specify direction option replaces all the 

individual direction options. Selecting this option means that if a 

collision is detected, the tool will tilt such that the tool tip tries to 

point towards or away from geometry specified in the Specified
direction frame. 

The Specified direction frame only becomes available when 

you select a Tilt method of Specify direction. The options 

displayed in this frame are exactly the same as those available in 

previous versions. 
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! There is a new option of Smoothing distance which enables 

smooth tool axis changes. To prevent sudden changes in the tool 

axis, the tool starts tilting before the collision is detected. This 

distance is the Smoothing distance. For more information see 

Smoothing (see page 10). 

Tilt method (Tool axis) 

There are three new Tilt method options: 

Lead then Lean - if a collision is detected, the tool will tilt from the 

original axis in the Lead direction until the collision is avoided. If the 

collision can't be avoided by tilting the tool in the Lead direction, the 

tool will tilt in the Lean direction until the collision is avoided. 

Lean then Lead - if a collision is detected, the tool will tilt from the 

original axis in the Lean direction until the collision is avoided. If the 

collision can't be avoided by tilting the tool in the Lean direction, the 

tool will tilt in the Lead direction until the collision is avoided. 

These two new options minimise the need to use the Specify direction 
option. They enable you to create a single toolpath over areas with several 

pockets and you no longer need to create individual toolpath for each 

pocket or the geometry to define the tool axis. 

This is best shown by example. 

In PowerMILL 10.0 the only options were: 

Tilt method - Lean
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 - shows the toolpath isn't created in the corners. 

or Tilt method - Specified direction and Tilt direction - From 
curve.

 - the curve used to generate the toolpath. 

 - an incomplete toolpath.  

The only way to resolve this would be to create a curve in each pocket 

and generate a separate toolpath for each pocket. 

In PowerMILL 2010 there is an additional option of: 

Tilt method - Lead then lean

This creates the desired result with one toolpath and there is no need to 

create any additional geometry. 
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Smoothing (Tool axis) 

The Smoothing tab on the Tool axis dialog smooths any changes in 

velocity or direction of the tool axis. This minimises judder on the 

machine tool. 

This tab is only available if you select Tool axis smoothing on the 

Definition tab. 

Elevation - determines whether and how to smooth the elevation angle 

of the tool axis. An elevation of 90  means that the tool is aligned with 

the Z axis, and an elevation of 0  means the tool is in the XY plane. 

None - no smoothing takes place. The tool axis orientation moves as and 

when it needs to move. 

Smoothed - the tool axis angle changes smoothly over the Smoothing
distance. The change in angle will not be more than the Maximum 
angular correction unless the angle of the unsmoothed toolpath varies 

by more than the Maximum angular correction in less than 

Smoothing distance. In such regions, the angle may change by more 

than the Maximum angular correction to give a smooth result. 
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Stepped on surface - the tool axis angle changes by up to the 

Maximum angular correction to form steps of constant value. To 

avoid sharp tool axis movements, a smooth transition between steps is 

made starting at the Smoothing distance away from the possible ends 

of neighbouring steps. The tool always remains in contact with the 

surface.

Stepped with links - as for Stepped on surface, the tool axis angle 

changes by up to Maximum angular correction to form steps of 

constant value. In this case, the toolpath segments are subdivided at the 

end of each step, and link moves are inserted so the tool axis changes 

when the tool is not in contact with the model. This means that tool axis 

angle of each toolpath segment is constant. 

Azimuth - determines whether and how to smooth the azimuth angle of 

the tool axis. Azimuth is the angle between the X axis and the projection 

of the tool in the XY plane. 

None - no smoothing takes place. The tool axis orientation moves as and 

when it needs to move. 

Smoothed - the tool axis angle changes smoothly over the Smoothing
distance. The change in angle will not be more than the Maximum 
angular correction unless the angle of the unsmoothed toolpath varies 

by more than the Maximum angular correction in less than 

Smoothing distance. In such regions, the angle may change by more 

than the Maximum angular correction to give a smooth result. 

Stepped on surface - the tool axis angle changes by up to the 

Maximum angular correction to form steps of constant value. To 

avoid sharp tool axis movements, a smooth transition between steps is 

made starting at the Smoothing distance away from the possible ends 

of neighbouring steps. The tool always remains in contact with the 

surface.



12 • Toolpath preparation PowerMILL 2010 What's New

Stepped with links - as for Stepped on surface, the tool axis angle 

changes by up to Maximum angular correction to form steps of 

constant value. In this case, the toolpath segments are subdivided at the 

end of each step, and link moves are inserted so the tool axis changes 

when the tool is not in contact with the model. This means that tool axis 

angle of each toolpath segment is constant. 

 - original toolpath, no smoothing. 

 - stepped toolpath. 

 - maximum angular correction limits. 

 - azimuth or elevation 

 - toolpath distance 

Maximum angular correction - smooths the azimuth and elevation 

angles of the tool axis by up to the angle specified here.  
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Smoothing distance - smooths the tool axis movement over the 

specified distance. When using a smoothing of Stepped on Surface, or 

when you get sudden changes in direction in the original toolpath (such as 

a right angled corner), you get rapid changes of orientation of the tool 

axis which leaves dwell marks. To prevent this, the Smoothing
distance blends the change in orientation and gives a much improved 

surface finish.  

 - original toolpath, no smoothing. 

 - smoothed stepped toolpath. 

 - maximum angular correction limits. 

 - azimuth or elevation 

 - toolpath distance 

Override toolpath workplane - a different workplane to the 

workplane used to generate the toolpath is used to define elevation and 

azimuth for smoothing. 

Workplane - the workplane used when smoothing. If no workplane is 

selected, the global coordinate system is used. 
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Orientation vector (Tool axis) 

Orientation vector steers the tool by aligning the vector in a particular 

orientation. The contact track of the tool remains unchanged, but the 

contact position on the tool is affected as the tool orientation changes.  

This is useful when: 

! Machining with an asymmetric machine head. 

! Using the C-axis rotation of the machine tool to machine a part 

which otherwise wouldn't fit within the machine tool limits. 

! Controlling the orientation of the end of the arm of a robot. 

This tab is only available if you select Orientation vector on the 

Definition tab. 

Orientation vector - determines the orientation of the tool. 

These options are easiest to see if you draw the orientation vectors (

on the Toolpath toolbar) and then simulate the toolpath (Simulate
from start on the individual toolpath menu). 

 shows the tool orientation. 

Free - the orientation vector is not controlled. 
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Fixed direction - the orientation vector always points in the same 

direction.

Direction of travel - the orientation of the vector is determined by the 

direction of travel. 

Offset angle - changes the orientation angle of the vector. This is used 

to orient the machine head correctly. 

These options are easiest to see if you draw the orientation vectors (

on the Toolpath toolbar) and then simulate the toolpath (Simulate
from start on the individual toolpath menu). 

 shows the tool orientation. 
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Offset angle - 0

Offset angle - 30

Direction - defines the vector of the line. The orientation vector is 

always perpendicular to the tool axis. When you have a non-vertical tool 

axis, the only way to specify the direction accurately is to specify the 

Azimuth and Elevation angles. This option is only available if you 

have an Orientation vector of Fixed direction.

Azimuth - determines the angle of the line in the XY plane. The rotation 

is measured anti-clockwise about the Z axis with 0 at the X axis. 

Elevation - determines the angle of the line relative to the vertical (Z). 

Smooth orientation vectors - avoids sharp changes in the tool 

orientation.

Maximum angle of correction - smooths the azimuth and elevation 

angles of the tool orientation by up to the angle specified here.  
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This is similar to the Maximum angle of correction on the 

Smoothing tab (see page 10), except that this works on the tool 

orientation and not the tool axis. 

Smoothing distance - smooths the tool orientation over the specified 

distance. When you get sudden changes in direction in the original 

toolpath (such as a right angled corner) you get rapid changes of 

orientation of the tool which leaves dwell marks. To prevent this, the 

Smoothing distance blends the change in orientation and gives much 

improved surface finish. 

These options are easiest to see if you draw the orientation vectors (

on the Toolpath toolbar) and then simulate the toolpath (Simulate
from start on the individual toolpath menu). 

 shows the tool orientation. 

Smooth orientation vectors - deselected:

Smooth orientation vectors - selected
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Smoothing Distance - 5:

This is similar to the Smoothing distance on the Smoothing
tab (see page 10) , except that this works on the tool orientation and 

not the tool axis. 

Definition tab 
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Orientation vector - enables the Orientation vector tab, which 

controls the tool axis orientation and displays the orientation vector  on 

the tool. When this option is selected,  is displayed on the Tool
toolbar.

Tool improvements 

There are several changes to the Tool  dialog. 

There are a couple of changes to the Tool Holder tab: 

! You can now have a tool holder with a negative overhang. 

You can have a negative Overhang, so the cutting part of the tool is 

above some of the holder elements. This is particularly useful when 

using a grinding wheel where the locking plates and lock nuts are 

below the cutting part of the tool. 

This enables you to define a grinding wheel as a tipped disk or routing 

tool.



20 • Toolpath preparation PowerMILL 2010 What's New

! The Overhang  button automatically calculates the overhang 

value, based on the tool's holder profile, to give the smallest, 

non-colliding value. 

In this case, with an Overhang of 100 the tool holder collides with the 

model: 

Clicking  calculates the smallest overhang to avoid collisions: 
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There is a new tab of Holder Profile (see page 21) which gives a fast 

way of collision checking. 

Tool Holder Profile 

The Tool Holder Profile tab of the Tool dialog calculates the 

maximum shape of a tool holder and shank on a toolpath during toolpath 

calculation. After the calculation, you can check that specific holders and 

shanks lie inside the maximum shape and are therefore capable of 

machining the part, without having to go through collision checking. 

Toolpath list - lists all the toolpaths that use this tool and shows 

whether the tool can machine the part. 

Toolpath - all the toolpaths which use this tool. 

Draw - draws (or undraws) the toolpath. This has the same state as the 

toolpath in the explorer.  
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Include - includes the toolpath in the tool profile calculation. 

Status - shows whether the tool can machine the part without the 

holder colliding. 

 the tool can machine the part without the holder colliding. 

 - the tool holder collides with the part. The colliding component 

is shaded red. 

 - the toolpath profile hasn't been calculated. 

Include All Toolpaths - selects all the calculated toolpaths. 

Converts this: 

to this: 

Exclude All Toolpaths - deselects all the calculated toolpaths. 

Converts this: 

to this: 

Copy Tool Profile - creates a copy of the tool and associates the 

selected toolpaths which were associated with the old tool with this new 

tool.
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This is best shown by example. 

1. Initially the tool has four toolpaths associated with it: 

2. Select two of the toolpaths  

3. Click . This leaves two toolpaths associated with the original 

tool:

and two toolpaths associated with the new tool: 

If you don't select any toolpaths, then all the toolpaths are 

associated with the new tool. 

This is similar to , as it creates a new tool entity based on the 

current one. With  the selected toolpaths which used the old 

tool, now use the new one. With , all the toolpaths, except for the 

active toolpath, still use the original tool. 

Clearance - the minimum allowable distance between the model and the 

tool profile.  

Maximum Profile Diameter - limits the maximum diameter of the 

profile to the value set here. 0.0 means that no maximum diameter is set. 
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Maximum Profile Diameter - 0.0 (unlimited): 

Maximum Profile Diameter - 90:

Refresh Profiles - calculates the profiles for any toolpath which has a 

status of .

Converts this: 
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to this: 

Tool Assembly - displays the defined tool tip, tool shank, tool holder, 

and tool holder profile. 

 - tool 

 - shank 

 - holder 

 - holder profile 

 - adds this tool to the tool database. The Tool Database Export
dialog is displayed. 

Creating a Tool Holder Profile 

This example shows you how to create a tool holder profile for several 

toolpaths.  

1. Calculate a variety of toolpaths using the same tool. 

2. From the individual tool context menu, select Settings.
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3. Select the Holder Profile tab. 

a. Click  to include all the toolpaths. 

b. Enter a Clearance of 2.5.

c. Enter a Maximum Profile Diameter of 0.0.

d. Click Refresh Profiles to calculate the holder profile and see 

if the holder collides with the model. 
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In this case, two toolpaths are fine and two have collisions between 

the lowest portion of the holder and the model. 

The red component of the tool holder shows the colliding portion. 

4. Select the Holder tab. 

5. Click  to automatically calculate a more appropriate 

Overhang.
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6. Select the Holder tab to see the effect of lengthening the 

Overhang value. 

You can calculate the tool holder profile automatically as part of 

the toolpath calculation by selecting Calculate holder profile on 

the Tool page of the strategy dialog. 
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Workplane Editing improvements 
A new Workplane Editor toolbar (see page 29) replaces the 

Workplane dialog and the workplane options on the Curve Editor
toolbar in previous versions. 

The Workplane Editor is available from: 

! The Workplanes context menu, select Create Workplane.

! The individual workplane context menu, select Workplane
Editor.

Workplane Editor toolbar 

The Workplane Editor toolbar allows you to create and edit 

workplanes.

Whilst in the Workplane Editor, no other entities can be edited, 

including other workplanes. As with the Curve Editor, PowerMILL 

enters a graphic mode where most of the user interface is greyed 

out.

Transform Copy - transforms a copy of the workplane, leaving the 

original in its current location and orientation. Clicking  changes the 

button to  which transforms the workplane without leaving the original 

workplane.

Name - the name of the workplane. You can edit the name here. 

 Position (see page 37) - aligns the workplane using typed 

coordinate input rather than using the cursor.  
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, , or Twist - rotates the workplane around the selected axis 

by the specified angle.  

Angle - the rotation required. 

Invert Angle - changes an anti-clockwise rotation to a clockwise 

rotation. So, an angle of 30  becomes 330 .

The axis that is fixed (the axis the workplane is being rotated 

around) is drawn in blue to show that it won't be modified. 

Angle - 0 :

For a rotation about X, Angle - 30 :

For a rotation about X, Angle - 330 :
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, , or Axis direction (see page 41) - determines the direction 

of the specified workplane axis. 

Rotate - rotates the workplane around the origin of the selected 

workplane by the selected angle. The Twist option rotates the workplane 

about itself. This option allows you to rotate the workplane about another 

workplane.

Angle - the required rotation angle in degrees. 

Reposition Rotation Axis - when selected, enables you to move 

the origin of the rotation axis either graphically or by entering coordinates 

in  or  on the Status toolbar. 

 Finish - accepts the changes and closes the toolbar. 

For more information, see the Rotate workplane example (see page 43). 

Swap axes - switches the direction of the workplane axes. For 

example, this enables you to orientate the Z axis along what is currently 

the X axis. 

Clicking one of these buttons allows you to specify a new direction for 

that axis. 

For more information, see the Swap axes example (see page 44). 

 Align with - orientates the workplane with the view, model, tool, or 

block.

Align with view - orientates the workplane so that it is aligned 

with the current graphics view. 
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The workplane is aligned with respect to the principal editing plane 

 that is selected on the Status bar. In this example, 

is the principal editing plane. 

Align with geometry - orientates the workplane so that it is 

normal to the surface at that point. 

The workplane is aligned with respect to the principal editing plane 

 that is selected on the Status bar. In this example, 

is the principal editing plane. 

Moving the cursor over the model changes its orientation. 
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Click on the model to reorientate the workplane. 

Align with geometry and reposition - orientates the 

workplane so that it is located where you select the surface and is 

normal to the surface at that point. The workplane changes its 

orientation and its position. 

The workplane is aligned with respect to the principal editing plane 

 that is selected on the Status bar. In this example, 

is the principal editing plane. 

Moving the cursor over the model moves the workplane and 

changes its orientation. 
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Click on the model to relocate and reorientate the workplane. 

Align with tool - orientates the workplane so that it is aligned 

with the tool axis. The workplane changes its orientation but not its 

position. 

The workplane is aligned with respect to the principal editing plane 

 that is selected on the Status bar. In this example, 

is the principal editing plane. 

Align with tool and reposition - orientates the workplane so 

that it is located at the tool centre with the Z axis aligned with the tool 

axis. The workplane changes its orientation and its position. 
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The workplane is aligned with respect to the principal editing plane 

 that is selected on the Status bar. In this example, 

is the principal editing plane. 

Align with block and reposition - orientates the workplane so 

that it is aligned with the selected control on the block. The workplane 

changes its orientation and its position. 

The block is drawn with a number of handles.  

Click any of these handles to create a workplane at that point, with 

the same orientation as the active workplane. 
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If the block isn't a rectangular block then a bounding box is 

placed around the block and the handles are placed on the 

bounding box. 

Workplane Align to Block  is only available if you have a 

block defined. 

 Undo - reverts to what it was before the last change. If you rotate the 

workplane by say 30 , then Undo  undoes this transformation. 

This option is only available once you have edited (transformed) the 

workplane.

 Redo - reinstates the edit you have just undone. 

This option is only available once you have undone  a 

transformation. 

 Accept Changes - accepts and keeps workplane orientation. The 

Workplane Editor toolbar is closed and normal PowerMILL 

functionality is enabled. 

 Cancel Changes - the workplane orientation reverts to what it was 

before you started editing it. The Workplane Editor toolbar is closed 

and normal PowerMILL functionality is enabled. 
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Position dialog 

The Position  dialog locates the item using typed coordinate input, 

though you can also use the cursor. 

There are two tabs: 

! Cartesian (see page 38) - define the item position using cartesian 

coordinates.

! Polar (see page 39) - define the item position using polar 

coordinates.

The Cartesian and Polar tabs are always synchronised. This means that 

there is a single underlying point represented in two different ways. 
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Position - Cartesian 

The Cartesian tab of the Position dialog displays the coordinates of 

the item location. You can use either the cursor, or typed coordinate input 

to specify the location. 

Workspace - determines which workspace you are working in.  

World - moves the item to the coordinates (in the global coordinate 

system) specified in the lower half of the dialog. 

Workplane - moves the item to the coordinates (in the active 

workplane) specified in the lower half of the dialog. 

This option is only available if an active workplane exists, 

and, if you are editing a workplane, you're editing a 

non-active one.  

Relative - moves the item to the coordinates specified in the lower 

half of the dialog. 

If any items are locked, the locks are discarded when you select a 

different workspace. 

Current Plane - select one of the three principal planes. The current 

plane is relative to the selected Workspace option. 

X, Y, Z - the typed coordinates. 

Locks - clamps values and prevents you from editing them. 

Unlocked - the field is unlocked and so can be edited. 

 Locked - the field is locked and so cannot be edited. 
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These two buttons work as a toggle. So, if you click the Unlocked

button it locks the field and changes the button to Locked , and 

similarly, if you click the Locked  button, it unlocks the field and 

changes the button to Unlocked .

Unlock All Limits - unlocks all the locked parameters. 

The locks on the Polar and Cartesian pages are not independent. 

Say, for example, you lock the angle to 45  with the current plane 

set to XY. If you then change X, Y will also change so that it 

respects the lock. 

Become Origin - the coordinates defined above become the item 

origin. Any relative coordinates are then measured from this origin. 

Position - Polar 

The Polar tab of the Position dialog displays the coordinates of the 

entity location. You can use either the cursor, or typed coordinate input to 

specify the location. 

Workspace - determines which workspace you are working in.  

World - moves the item to the coordinates (in the global coordinate 

system) specified in the lower half of the dialog. 

Workplane - moves the item to the coordinates (in the active 

workplane) specified in the lower half of the dialog. 

This option is only available if an active workplane exists, 

and, if you are editing a workplane, you're editing a 

non-active one.  
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Relative - moves the item to the coordinates specified in the lower 

half of the dialog. 

If any items are locked, the locks are discarded when you select a 

different workspace. 

Current Plane - select one of the three principal planes. The current 

plane is relative to the selected Workspace option. 

Angle - the polar angle from the origin in the Current Plane and 

Workspace.

Distance

Distance - the distance from the workplane origin. 

X, Y, or Z - the distance on either of the axes of the Current Plane.

Elevation

Elevation - the angle of elevation above the active plane from the 

origin of the workspace. 

Height - the distance perpendicular to the selected plane. For 

example, the Z component when the XY plane is selected. 

Locks - clamps values and prevents you from editing them. 

Unlocked - the field is unlocked and so can be edited. 

 Locked - the field is locked and so cannot be edited. 

These two buttons work as a toggle. So, if you click the Unlocked

button it locks the field and changes the button to Locked , and 

similarly, if you click the Locked  button, it unlocks the field and 

changes the button to Unlocked .

Unlock All Limits - unlocks all the locked parameters. 

The locks on the Polar and Cartesian pages are not independent. 

Say, for example, you lock the angle to 45  with the current plane 

set to XY. If you then change X, Y will also change so that it 

respects the lock. 

Become Origin - the coordinates defined above become the item 

origin. Any relative coordinates are then measured from this origin. 
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Direction dialog 

Edits the direction of the item. A direction is defined in terms of a unit 

vector.

Workspace - determines which workspace you are working in.  

World - moves the item to the coordinates (in the global coordinate 

system) specified in the lower half of the dialog. 

Workplane - moves the item to the coordinates (in the active 

workplane) specified in the lower half of the dialog. 

This option is only available if an active workplane exists, 

and, if you are editing a workplane, you're editing a 

non-active one.  

Align to workspace - aligns the selected workplane axis to the chosen 

axis of the global coordinate system. 

The effect of this option is best shown by example. 

If you start with this: 

 - the workplane that you are editing 

 - the active workplane (or the global coordinate system if there 

is no active workplane). 
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1. On the Workplane Editor toolbar click .

2. In the Direction dialog click . The workplane changes to: 

The X axis of the workplane is aligned with the Y axis of the 

global coordinate system. 

3. In the Direction dialog click . The workplane changes to: 

The X axis of the workplane is aligned with the -Z axis of the 

global coordinate system. 

 positive X-axis 

 positive Y-axis 

 positive Z-axis 

 negative X-axis 

 negative Y-axis 

 negative Z-axis 

Direction - the I, J, and K coordinates for the unit vector. 

Apparent angles - the apparent angle of the unit vector from the axis 

of the plane shown by the icon.  
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Rotate workplane 

This example shows you how to rotate a workplane. 

1. Click the Rotate  button from the Workplane Editor
toolbar. This displays the Rotate Workplane toolbar. 

It also show the point about which the workplane will be rotated. 

 - the workplane that you are editing 

 - the active workplane (or the global coordinate system if there 

is no active workplane). 

 - the rotation point 

 - the rotation axis. 

2. Enter an Angle of 90.

3. The cursor changes to .
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4. Either click in the graphics area to locate the new origin or enter 

the required coordinates in  or 

on the Status toolbar. 

5. Enter an Angle of 45.

If you click  the Position  dialog (see page 37) becomes 

available on the Status bar. 

Swap axes 

This example shows you how to swap the axes a workplane. 

1. Click the Swap axes   button from the Workplane Editor
toolbar. This displays the Swap Axes toolbar with the Specify Z 

axis  button selected. 

If you want to change the axis you are currently selecting, 

simply select the relevant button on the Swap Axes toolbar. 

So if you want to specify the Y axis click .
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The workplane is now displayed as 8 arrows, to indicate the 

possible options. 

2. Hover over any of the arrows to highlight the arrow, display the 

axis label, and remove the opposite arrow. 

3. Selecting the arrow makes the label permanent. 

The Specify X axis  button is now selected. 

4. Hover over one of the four remaining axis to highlight it and to 

label the two remaining axes. 
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5. Selecting the arrow makes the label permanent and closes the 

Swap axes toolbar. 
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Curve editor enhancements 
There are additional buttons on the Curve Editor toolbar. 

Reverse Selected Items - reverses the direction of the selected 

items. 

Converts this: 

to this: 

If you select a polyline there is no arrow on the line, but the X marks the 

end of the polyline. 

For more information, see Reverse selected item example (see page 

49).

Select Points on Curve - selects points which you can then edit or 

delete.

Displays the Select Points dialog (see page 50). 

You can select a point by either: 
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! Selecting it graphically. 

or:

! Selecting it from the Select Points dialog. 

A red circle is placed on the selected point. 

You can select additional points graphically using the Shift key. You 

can deselect points using the Ctrl key. Shift plus a drag box selects 

all the points in the box and Ctrl plus a drag box deselects all the 

points in the box. 

Insert Point (see page 51) - adds a point between a pair of selected 

points. 

Delete Points - deletes the selected point. 

Converts this: 

To this: 

Number Points - numbers the points on the selected curve. 

There are new interactive editing capabilities for: 
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! Lines (see page 52) - enables you to move the start or end point of 

a line. 

! Arcs and circles (see page 55) - enables you to change the 

radius and the arc length. 

! Continuous lines (see page 57) - enables you to move individual 

points on the polyline. 

All coordinate input that used to appear on separate sub-toolbars is now 

available on the Status bar (see page 167). 

Context menus are now available from the graphics window. When the 

Curve Editor toolbar is displayed, right click in the graphics area to 

display the Curve Editor menu (see page 58). Similarly right click on a 

Line (see page 62), Arc (see page 64) or Continuous line (see page 

67) to display their menus. 

Reverse selected items example 

To see the effect of Reverse selected items  you must 

Instrument  the curve. 

If you start with these curves: 

1. Click  to instrument the curve. 
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2. Select the curves you want to reverse. 

The selected curves turn yellow. 

3. Click  to reverse the selected curves. 

You must select the curve before you can reverse it. The yellow 

curves (the selected curves) are reversed and the orange ones 

aren't.

If you just select a single curve, you don't need to instrument the 

curve first. 

Select Points dialog 

You can select points from the list on the left hand side of the dialog. This 

lists supports normal Windows multi-selection options. 

 - selects all the points. 

 - toggles the selection. So it deselects selected points and selects the 

deselected ones. 
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 - deselects all the points. 

Insert Point into Curve dialog 

There are three ways of inserting points: 

! At a specified parameter value. 

! At the closest point on the curve to the specified point. 

! At a distance along a curve, from the specified point. 

These options are shown using this curve. 

Parameter value 

Entering a value of 2.25 and clicking Apply, inserts a point 1/4 of the 

way between point 2 and point 3. 
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Through nearest point 

Entering a value of X - 60, Y - -21, Z - 0, inserts this point: 

and updates the dialog with the actual coordinates of the point. 

You can use the Position  dialog (see page 37) to enter the 

coordinates, or select a point graphically. 

Distance from point 

Select point 3. 

Entering a Distance from current point of 10 and click Apply.

Editing a line 

1. Select a line to edit it.  

The line is yellow and has a blue handle at each end. 

If you aren't in curve editing mode select the line to edit it. 
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2. Selecting one of the handles (the cursor changes to ) and 

dragging it to a new position changes the length and angle of the 

line.

3. Selecting the line (the cursor changes to ) and dragging it to a 

new position changes the location but not the length or orientation. 

4. A PowerMILL Query dialog asks you to confirm the drag. 

Double clicking the line displays the Line Editor dialog (see page 

53).

Line Editor dialog 

This dialog edits a line.  

Workspace - edits the line in world, workplane, or relative workspace. 

The relative workspace has its origin at the start of the line and its 

axes aligned with the current workspace 

Length - the length of the line so that it extends or shrinks from its end. 

Start - the start coordinates of the line. 

End - the end coordinates of the line. 

Reverse the line - reverses the direction of the selected line. 

Converts this: 
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to this: 

Start / End point position (see page 37) - use the Position
dialog to enter the coordinates. 

Angle - the angle of line is defined in terms of apparent and elevation 

angles on the selected plane. 

 - the selected plane. 

Apparent - the angle measured between the projection of the line onto 

the selected plane and an axis of the plane. The axis used is the X axis if 

the selected plane is XY, Y if it is YZ and, Z if it is ZX.  

 - Apparent angle on the XY plane. 

Elevation - the angle measured between the line and the projection of 

the line onto the selected plane.  

 - Elevation angle in the XY plane. 

You can still graphically edit the line whilst the Line editor dialog 

is displayed, but you can't deselect the line or select anything else. 
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Editing an arc 

1. Select an arc to edit it.  

The arc is yellow, has a blue handle at each end, and arrows 

indicating the radius. 

If you aren't in curve editing mode, select the arc to edit it. 

2. Selecting one of the handles (the cursor changes to ) and 

dragging it to a new position changes the span angle. 

3. Selecting the arrows (the cursor changes to ) and dragging it to a 

new position changes the radius. 

4. Selecting the origin (the cursor changes to ) and dragging it to a 

new position changes the location but not the span or radius. 

5. A PowerMILL Query dialog asks you to confirm the drag. 

Double clicking the arc displays the Arc Editor dialog (see page 

56).
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Arc Editor dialog 

This dialog edits an arc or circle.  

Radius/Diameter - determines whether you are specifying the radius or 

diameter of the arc/circle. The actual radius/diameter is specified in the 

next field. 

Span angle - the span of the arc in degrees. 

Span angle - 135 :

Span angle - 270

Make full arc - converts an arc to a circle. 

Converts this: 

to this: 

 Reverse the arc - reverses the direction of the selected arc. 
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Converts this: 

to this: 

Workspace - edits the arc in world, workplane, or relative workspace. 

Centre - the centre coordinates of the circle. 

Through - the coordinates of a point on the circumference of the circle. 

Centre / Through position (see page 37) - use the Position
dialog to enter the coordinates. 

You can still graphically edit the arc whilst the Curve editor
dialog is displayed, but you can't deselect the arc or select anything 

else.

Editing a polyline 

1. Select a polyline to edit it.  

If you aren't in curve editing mode, select the poyline to edit 

it.  

2. Selecting one of the points (the cursor changes to ) and dragging 

it to a new position changes the point location. 
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3. Use Shift and place a drag box around the middle points. 

The middle points are selected. 

4. Toggle  on the Status bar so  is displayed. 

5. In  on the Status bar enter 20 30 0 and click enter. 

The middle points are moved. 

You could also use the Position  dialog rather than entering 

coordinates.

Curve editor menu 

The Curve editor context menu is raised by right clicking in the 

graphics area when the Curve editor toolbar is raised. 
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Accept Changes - accepts and keeps all the created curves. The 

Curve editor toolbar is closed and normal PowerMILL functionality is 

enabled. This is the same as  on the Curve editor toolbar. 

Cancel Changes - deletes all the created curves. The Curve editor
toolbar is closed and normal PowerMILL functionality is enabled. This is 

the same as  on the Curve editor toolbar. 

Delete selected - deletes the selected items. This is the same as  on 

the Curve editor toolbar.

Reverse selected - reverses the direction of the selected items. This is 

the same as  on the Curve editor toolbar. 

Converts this: 

to this: 

If you select a polyline there is no arrow on the line, but the X marks the 

end of the polyline. 

For more information, see Reverse selected item example (see page 

49).

Split Selected - breaks the selected segments into the individual curves 

used to create the curves. This is the same as  on the Curve editor
toolbar.

Merge selected - merges individual selected segments into one curve. 

This is the same as  on the Curve editor toolbar. 

Undo - reverts to what it was before the last change. This is the same as 

 on the Curve editor toolbar. 

Redo - reinstates the edit you have just undone. This is the same as 

on the Curve editor toolbar. 
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Select all - selects all the curves. This is the same as  on the Curve
editor toolbar.

Select toggle - deselects the selected curves and selects the deselected 

curves. This is the same as  on the Curve editor toolbar.

Converts this: 

to this: 
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Select closed - selects all the closed curves and deselects the open 

curves. This is the same as  on the Curve editor toolbar.

Clear selection - deselects the selected curves. 

Colour - changes the colour of the selected segments. This displays a 

standard Windows colour dialog, selecting a colour here changes the 

colour of the selected curves. If no segments are selected, this option sets 

the default colour for all new segments. This is the same as  on the 

Curve editor toolbar. 

Instrument - all curves in a pattern have a direction. If you instrument a 

pattern, it will place an arrow on each segment (pointing towards the end 

of the segment) and an "X" at the end of each segment. This is the same 

as  on the Curve editor toolbar. 
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Line menu 

The Line context menu is raised by right clicking on a line when the 

Curve editor toolbar is raised. 

Modify (see page 52) - selects the line and displays the Line Editor
dialog (see page 53) so you can edit the location or length of the line. 

Edit as continuous line (see page 57) - selects the line so you can edit 

the location, or length of the line in the same way as a continuous line. 

Reverse - reverses the direction of the selected items. This is the same 

as  on the Curve editor toolbar. 

Converts this: 

to this: 

Delete selected - deletes the selected line. This is the same as  on 

the Curve editor toolbar.

Merge with adjoining segments - merges all the segments adjacent 

to the picked segment. The curve editor automatically searches for 

segments that join the picked segment, at either end, and merges them. 

The search then starts again on this new segment, to see if any segments 

join it. If they do, then they are merged. This continues until no more 

merges are possible. Where there is a choice of curves to merge, the curve 

with the smallest tangent angle discrepancy is chosen. This is the same as 

 on the Curve editor toolbar. 

Undo - reverts to what it was before the last change. This is the same as 

 on the Curve editor toolbar. 
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Redo - reinstates the edit you have just undone. This is the same as 

on the Curve editor toolbar. 

Select all - selects all the curves. This is the same as  on the Curve
editor toolbar.

Select toggle - deselects the selected curves and selects the deselected 

curves. This is the same as  on the Curve editor toolbar.

Converts this: 
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to this: 

Select closed - selects all the closed curves and deselects the open 

curves. This is the same as  on the Curve editor toolbar.

Clear selection - deselects the selected curves. 

Arc menu 

The Arc context menu is raised by right clicking on an arc when the 

Curve editor toolbar is raised. 



PowerMILL 2010 What's New Toolpath preparation • 65

Modify (see page 55) - selects the line and displays the Arc Editor
dialog (see page 56) so you can edit the radius or span of the arc. 

Reverse - reverses the direction of the selected items. This is the same 

as  on the Curve editor toolbar. 

Converts this: 

to this: 

If you select a polyline there is no arrow on the line, but the X marks the 

end of the polyline. 

For more information, see Reverse selected item example (see page 

49).

Delete selected - deletes the selected arc. This is the same as  on 

the Curve editor toolbar.

Merge with adjoining segments - merges all the segments adjacent 

to the picked segment. The curve editor automatically searches for 

segments that join the picked segment, at either end, and merges them. 

The search then starts again on this new segment, to see if any segments 

join it. If they do, then they are merged. This continues until no more 

merges are possible. Where there is a choice of curves to merge, the curve 

with the smallest tangent angle discrepancy is chosen. This is the same as 

 on the Curve editor toolbar. 

Undo - reverts to what it was before the last change. This is the same as 

 on the Curve editor toolbar. 

Redo - reinstates the edit you have just undone. This is the same as 

on the Curve editor toolbar. 
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Select all - selects all the curves. This is the same as  on the Curve
editor toolbar.

Select toggle - deselects the selected curves and selects the deselected 

curves. This is the same as  on the Curve editor toolbar.

Converts this: 

to this: 
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Select closed - selects all the closed curves and deselects the open 

curves. This is the same as  on the Curve editor toolbar.

Clear selection - deselects the selected curves. 

Continuous line menu 

The Continuous line context menu is raised by right clicking on a 

continuous line when the Curve editor toolbar is raised. 

Reverse - reverses the direction of the selected items. This is the same 

as  on the Curve editor toolbar. 

Converts this: 

to this: 
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Delete selected - deletes the selected line. This is the same as  on 

the Curve editor toolbar.

Split - breaks the selected segments into the individual curves used to 

create the curves. 

Merge with adjoining segments - merges all the segments adjacent 

to the picked segment. The curve editor automatically searches for 

segments that join the picked segment, at either end, and merges them. 

The search then starts again on this new segment, to see if any segments 

join it. If they do, then they are merged. This continues until no more 

merges are possible. Where there is a choice of curves to merge, the curve 

with the smallest tangent angle discrepancy is chosen. This is the same as 

 on the Curve editor toolbar. 

Select points - selects points which you can then edit or delete. This is 

the same as  on the Curve editor toolbar. 

Displays the Select Points dialog (see page 50). 

You can select a point by either: 

! Selecting it graphically. 

or:

! Selecting it from the Select Points dialog. 

A red circle is placed on the selected point. 



PowerMILL 2010 What's New Toolpath preparation • 69

You can select additional points graphically using the Shift key. You 

can deselect points using the Ctrl key. Shift plus a drag box selects 

all the points in the box and Ctrl plus a drag box deselects all the 

points in the box. 

Insert points (see page 51) - adds a point between a pair of selected 

points.This is the same as  on the Curve editor toolbar. 

Insert points here - adds a point where you selected the continuous 

line. This is the same as  on the Curve editor toolbar and then 

selecting the Through nearest point tab on the Insert Point into 
Curve dialog (see page 51). 

Delete points - deletes the selected point. This is the same as  on 

the Curve editor toolbar. 

Converts this: 

To this: 

Number points - numbers the points on the selected curve. This is the 

same as  on the Curve editor toolbar. 

Undo - reverts to what it was before the last change. This is the same as 

 on the Curve editor toolbar. 

Redo - reinstates the edit you have just undone. This is the same as 

on the Curve editor toolbar. 
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Select all - selects all the curves. This is the same as  on the Curve
editor toolbar.

Select toggle - deselects the selected curves and selects the deselected 

curves. This is the same as  on the Curve editor toolbar.

Converts this: 

to this: 
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Select closed - selects all the closed curves and deselects the open 

curves. This is the same as  on the Curve editor toolbar.

Clear selection - deselects the selected curves. 



72 • Toolpath preparation PowerMILL 2010 What's New

Boundary improvements 
There are several improvements to 3D offsetting of boundaries. 

! The calculation is run in multiple threads. So it is noticeably faster 

on multi-core machines.  

! You can now create two types of boundary offsets (see page 72): 

Offset 3D (Smooth) - offsets a 3D boundary by a specified 

distance. A positive value offsets the boundary outwards, a negative 

valued offsets the boundary inwards. 

Offset 3D (Round Corners) - this is very similar to Offset 3 
(Smooth) except that the offset pattern isn't smoothed. This was the 

only option available in previous versions. 

There is a new option on the Silhouette Boundary dialog (see page 

73) of Vertical Tolerance which prevents spikes occurring on/near 

vertical surfaces. 

Smooth 3D boundary offsets 

You can now create two types of boundary offsets from the individual 

boundary context menu, and selecting Edit > Offset 3D (Smooth) or 

Edit > Offset 3D (Round Corners).

Starting with 5axisModel.dgk in the examples file with a selected 

surface boundary: 

You are then asked for an offset distance. 
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The Offset 3D (Smooth) boundary becomes: 

The Offset 3D (Round Corners) boundary becomes: 

Silhouette boundary improvements 

When creating silhouette boundaries on near-vertical surfaces, very spiky 

boundaries are sometimes produced. There is a new option on the 

Silhouette Boundary dialog of Vertical Tolerance which prevents 

these spikes occurring. 
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Vertical Tolerance - 0:

This is theoretically correct as the silhouette boundary is where the tool 

touches the outside edge of the model when viewed from above, but isn't 

what you want. 

Vertical Tolerance - 0.2:

The Vertical Tolerance must be less than the tool radius. 

Date on Models 
Models now have a date showing when they were imported into the 

project. This is displayed in the explorer: 
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If you edit the model, a modified date is also displayed: 

Stock model enhancements 
There are additional options to the individual stock model menu. 

The Drawing Options menu has three additional options: 

Show All Material - shows the underlying stock model. 

Show Rest Material - compares the stock model with the actual model. 

It shows the areas of the stock model where additional material is present 

to a thickness greater than the Rest Thickness. This is useful to 

indicate where excessive material has been left on, especially to spot 

areas on a vertical face where the stepover was set so that it just got 

missed. This option has moved from the main individual stock model 

context menu to the Drawing Options menu. 
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Taking a stock model of a couple of finishing toolpaths: 

If you Show the Rest Material you can see where excess material still 

remains: 

Show Removed Material - shows the stock that has been removed by 

the active stock model state. It is the difference between the stock 

remaining after the current state is taken away from the stock remaining 

after the previous state. 

If the current state has a stock model of: 
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and the previous state has a stock model of: 

then Show Removed Material displays: 

The Apply menu has two additional options: 

Active Tool First - removes all material accessible by the tool in 3-axis 

and places the tool state at the top of the stock model list. If the stock 

model is newly created (no block has been applied) then the block is 

applied automatically. 

Active Tool Last - removes all material accessible by the tool in 3-axis 

and places the tool state at the bottom of the stock model list. If the stock 

model is newly created (no block has been applied) then the block is 

applied automatically. 

 - insertion point if you select First.

 - insertion point if you select Last.
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The ability to add a tool to the stock model has introduced a new Stock 

Models tool state menu (see page 78). 

Stock Models tool state menu 

The stock model tool state menu controls the state of the entities in the 

stock model. 

Stock - this is the name of the menu. 

Calculate - calculates the stock model state. 

Queue - checks that all the parameters used to calculate the stock model 

are acceptable, adds the stock model to the calculation queue and closes 

the dialog. The stock model is calculated in the background when 

PowerMILL would otherwise be idle. 

Lock - locks the tool so that you cannot edit the tool settings. If you try 

to edit the tool settings (from the Settings option of the individual tool 

context menu and then editing a value) you will see an error message. 

Activate - becomes the active stock model state. If the stock model has 

been calculated, then you will see the state of the stock model after this 

entity has been applied. If you cannot see the stock model then you need 

to Calculate the stock model (from the individual context menu). 
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When the Block is activated: 

You will see the stock model of the block: 

Similarly, when the Rest Roughing toolpath is activated: 
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You will see the stock model after the rest roughing toolpath has been 

calculated: 

Set Radial Thickness - the radial thickness that is used to define the 

stock model state. You can't change this value after the stock model state 

has been calculated.  

Enter a thickness and click .

Set Axial Thickness - the axial thickness that is used to define the 

stock model. You can't change this value after the stock model state has 

been calculated.  
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Enter a thickness and click .

Set Corner Radius (TDU) - the corner radius that is used to define the 

stock model. You can't change this value after the stock model state has 

been calculated.  

Enter a radius and click .

Set Workplane - uses the active workplane to define the stock model 

state. If there is no active workplane, then any that has previously been 

set for this state will be removed. You can't set or change the workplane 

after the stock model state has been calculated. 
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Set Boundary - uses the active boundary to define the stock model 

state. If there is no active boundary, then any boundary that has 

previously been set for this state will be removed. You can't set or change 

the boundary after the stock model state has been calculated. 

Remove - removes this state from the stock model. This will only work 

if the tool is unlocked.  

Apply Toolpath After - applies the active toolpath and places the 

toolpath after this tool state in the stock model list. This only works if the 

tool is unlocked. 

If the AC and RestRoughing toolpaths are calculated but the 

ConstZFine toolpath is not then you can use the Apply Toolpath 
After option on the RestRoughing or ConstZFine toolpaths, but not 

on the AC toolpath or the Block.

 - toolpaths can be added after these states. 

 - toolpaths cannot be added after these states. 

 - not calculated. 

Apply Tool After - applies the active tool and places the tool after this 

tool state in the stock model list. This only works if the tool is unlocked. 
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If the AC and RestRoughing toolpaths are calculated but the 

ConstZFine toolpath is not, then you can use the Apply Toolpath 
After option on the RestRoughing or ConstZFine toolpaths, but not 

on the AC toolpath or the Block.

 - tool can be added after these states. 

 - tools cannot be added after these states. 

 - not calculated. 

Remove Calculation - removes the calculation. It leaves everything 

else alone, so the stock model definition remains the same, but the pink 

stock model mesh (or the shaded stock model) disappears.  

If you remove the calculation of every state (you can do this by just 

removing the calculation of the block), then you are free to edit the 

stock model parameters (tolerance, stepover, workplane…). In this 

way, you can generate a stock model at different tolerances without 

having to reapply the toolpaths. 

Converts this: 
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to this: 
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New machining strategy dialog 
Many of the existing machining strategies now use the new style 

machining strategy dialog. This is a tabbed dialog where the pages are 

selected from the tree in the left hand panel. It is simpler to use and 

provides an easier way to create toolpaths. 

Toolpath generation 
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The idea is that: 

! Each strategy has a few pages which are specific to that strategy, 

but the majority of pages are the same for all strategies. 

! The pages are placed in the same order for all strategies. 

! The page order reflects the work flow that you are likely to use. 

The workplane, block, and tool pages are all above the actual 

strategy page as you will want to define these before defining the 

specific strategy options. The expert pages are placed towards the 

bottom of the list. 

! The tabbed dialog uses a tree to control the separate pages and 

includes a diagram to give a visual description of the function of 

that page. 

! The tree in the tabbed dialog looks the same as that in the explorer, 

it has the same icons, labels, and order. 

Area Clearance strategies 
Most of the area clearance dialogs now use the new style strategy dialog. 

As well as converting them to the new style, there has also been a change 

in the way strategies are displayed in the Strategy Selector dialog. 

The main changes are: 

! Raster and Offset Model area clearance strategies are now 

combined into one strategy called Model Area Clearance. You 

can choose between Raster, Offset model, and Offset All
machining in the Styles area on the main page of the Model 
Area Clearance strategy. The sub-pages displayed depend on the 

options selected on the main page. For example, if you select 

Raster as the machining Style, then a Raster page is displayed. 

! Raster and Offset Feature Set area clearance strategies are now 

combined into one strategy called Feature Set Area Clearance.

As in the Model Area Clearance strategy, you can choose 

between the Raster, Offset model, and Offset Styles of 

feature machining. 

! There are separate Rest area clearance strategies for models and 

feature sets which contain rest machining options. 

! There are some changes to the profile and 2D curve area clearance 

dialogs to improve consistency between all the strategy dialogs. 

! There is a new Corner Clearance strategy (see page 109). 
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! The feature set options are still available on the 2.5D Area 
Clearance tab and the model options are still on the 3D Area 
Clearance tab. 

! Plunge Milling still uses the old style dialog. 

! Area clearance strategies have been improved to avoid creating 

thin slivers of material (see page 88). 

! Area clearance strategies have also been improved to have better 

start points, minimising rapid moves (see page 89). 

! Surfaces with a collision status are now treated the same when area 

clearing and finishing. In both cases, the segments of toolpaths 

which don't touch the collision mode surfaces (up to a previously 

defined thickness) are machined and those which touch are filtered 

out. In previous versions this was true of finishing toolpaths but not 

area clearance ones. 
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Sliver removal 

In PowerMILL 2010, area clearance strategies have been improved to 

avoid machining thin slivers of material which appear on the block edge 

towards the end of machining an area. Slivers occur when using the 

Offset all area clearance style with the Maintain cut direction option 

enabled.

Some offset area clearance toolpaths have a tendency to start machining 

from the innermost offset and finish with the outermost offset, which is 

usually in contact with the block edge. It is common to end up with a thin 

sliver of material to machine at the edge of the block. These thin slivers 

of material can damage both tool and stock edges and is an unwanted 

characteristic of area clearance strategies. 

PowerMILL 2010 prevents these thin slivers and adjusts the stepover to 

ensure a reasonable amount of material is removed with the last pass. 

Comparing a toolpath created in PowerMILL 10.0 with a toolpath created 

in PowerMILL 2010: 

In PowerMILL 2010 In PowerMILL 10.0 

 - Sliver of left over material. 

In PowerMILL 2010, the improved strategy creates toolpaths that avoids 

creating thin slivers of material. 
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Toolpath start points and ordering 

Area clearance toolpaths are more efficient and better structured. 

The significant improvements are: 

! Improvements to toolpath ordering when rest roughing areas. This 

significantly reduces the length of rapid moves between areas. 

! General improvements to toolpath ordering in related drilling and 

curve profiling strategies. 

! In rest roughing toolpaths, the positioning of start points on closed 

toolpath segments are much improved. 

For example, in previous PowerMILL versions, when thickness on 

a rest roughing toolpath was reduced in comparison to the 

reference toolpath, it created large numbers of closed segments 

with start points placed randomly. This resulted in inefficient 

toolpaths. In PowerMILL 2010, the start points are positioned as 

close as possible to the end point of the previous segment, reducing 

the length of rapid moves. 

This change only affects closed toolpath segments in rest 

roughing, typically when the thickness has been reduced. 

Comparing toolpaths from PowerMILL 10.0 and PowerMILL 2010: 

PowerMILL 2010 toolpath 

 - Toolpath start points in PowerMILL 10.0 
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PowerMILL 10.0 toolpath 

 - Toolpath start points in PowerMILL 2010  

Steep and shallow finishing - overview 
There is a new Steep and shallow finishing strategy which calculates 

a shallow boundary, and then creates Constant Z toolpath in the steep 

areas of a model and Raster or 3D offset toolpath in the shallow areas.  

This replaces Interleaved constant Z finishing in previous versions 

which only allowed 3D offsets in the shallow areas.  

This differs from Optimised constant Z finishing as you can specify 

the angle to change from 3D offset machining to constant Z machining. 
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The addition of Wall clearance on the Raster page (see page 102) can 

be used to prevent dwell marks on the steep areas. This means that you no 

longer have to apply a thickness to steep walls. 

 - Shows the 3D Offset toolpath in the shallow areas. 

 - Shows the Constant Z toolpath in the steep areas. 

There are three tabs associated with Steep and shallow finishing:

! Steep and shallow finishing (see page 92) - the main page 

used to define a steep and shallow finishing toolpath. 

! Shallow (see page 100) - defines the options for the shallow 

portion of the toolpath. This page is only available if you select 

Use separate shallow options.

! Raster (see page 102) - defines the raster options for the toolpath. 

This page is only available if you select a Type of Raster.
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! Automatic verification (see page 105) - enables automatic 

verification of toolpaths on creation. 

Steep and shallow finishing 

Steep and shallow finishing strategy creates a Constant Z toolpath 

in the steep areas of a model and a 3D offset or Raster toolpath in the 

shallow areas. This differs from Optimised constant Z finishing as 

you can specify when to change from 3D offset machining to constant Z 

machining using the Threshold angle field, and you can specify an 

Overlap where both steep and shallow toolpaths are created. 

Also, optimised constant Z finishing only uses whole segments, whereas 

steep and shallow finishing will split segments at the shallow boundary. 

This means that steep and shallow finishing toolpaths have far more 

retracts than optimised constant Z toolpaths. 
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Spiral - produces a spiral path between two consecutive closed contours. 

This minimises the number of lifts of the tool and maximises cutting time 

while maintaining more constant load conditions and deflections on the 

tool. It converts this: 

to this: 

Type - determines whether a Raster or Offset toolpath is created in the 

shallow regions. 
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Type - Offset

Type - Raster 

As a general rule, use raster on open edged parts and 3D offsets at 

the bottom of a pocket. 

Smoothing - smooths offsets of toolpath segments over the model. 

Selecting the Smoothing option converts this: 
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to this: 

This option is only available if you have a Type of 3D offset.

Order - determines the order in which the steep and shallow portions are 

machined.

Top First - machine from the top regions downwards. If you have a 

boss, the shallow regions at the top of the boss are machined before the 

constant Z sections (steep regions) down the sides. 

Steep First - machines the steep sections before the flat. If you have a 

boss, the constant Z sections (steep regions) are machined before the 

shallow regions. 

Additional stock - aids ordering when machining between two steep 

walls. It produces a safe order with the level of stock specified here. 

Providing the passes are within the distance specified, an alternating 

toolpath is created, machining at one Z height on one wall, and then at the 

same Z height on the neighbouring wall before descending to the next Z 

height.

If the Additional stock is zero then a default value of one tenth of 

the tool radius is used. 

This option is only available if you have an Order of Steep first.
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Threshold angle - the surface slope, measured from the horizontal, that 

determines the split between constant Z (steep) and shallow machining. 

 - Shows the 3D Offset toolpath in the shallow areas. 

 - Shows the Constant Z toolpath in the steep areas. 
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Steep shallow overlap - the size of the overlap area where constant Z 

(steep) and shallow machining occur. This minimises marks on the model 

caused by a sudden switch from constant Z to shallow machining. 

 Shows the 3D Offset toolpath overlapping into the steep areas. 

 Shows the Constant Z toolpath. 

Tolerance - determines how accurately the toolpath follows the 

contours defined by the model. 

Cut direction - determines the milling strategy. 

Climb - creates toolpaths using only climb milling. 

Conventional - creates toolpaths using only conventional or 

'upcut' milling. 

Any - creates toolpaths using both conventional and climb milling, 

as appropriate. This minimises the tool lifts and tool travel.  

Thickness - specifies the amount of material to be left on the part, 

within tolerance. 

 - clicking the Thickness  button changes the 

Thickness field to Radial thickness  and the Axial thickness

 field appears. Now you can specify separate Radial and Axial

thickness values .
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 Thickness - applies the thickness as an offset to the tool in all 

directions: 

 Radial thickness - applies the thickness as an offset to the tool 

radially. This can be useful where you want to leave material on 

vertical walls. 

 Axial thickness - applies the thickness as an offset to the tool, 

in the tool axis direction only. This controls the tip position of the tool 

used for machining, relative to the tool defined in PowerMILL. 

Variable thickness (that is to say, separate Radial and Axial
thickness values) is particularly useful for orthogonal parts. It is 

possible to use variable thickness on sloping walled parts, although it 

is more difficult to predict the results. 
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In thin-walled aerospace parts, you may want the area clearance 

toolpath to finish the floor of the pocket, but to leave material on the 

thin vertical walls. In this case, specify a positive Radial thickness 
value and an Axial thickness of 0:

 - Radial thickness 

Alternatively, you can also use this method to finish the steep side 

walls and leave material on the bottom. In this case, specify a Radial
thickness of 0 and a positive Axial thickness value: 

 - Axial thickness 

Typically, it is used on flat-bottomed parts with pockets. 

To avoid too much material being removed, Thickness should be 

greater than Tolerance.

Stepover - the distance between successive machining passes. 

 Set stepover from tool - automatically defines the stepover from 

the tool geometry. 

 Edited - the value is entered by you (or another user). Click  to 

change this to the automatically calculated value. 
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 Stepover - the distance between successive machining passes.  

If you enter a Stepover value, then  changes to .

Cusp height - specify the desired maximum cusp height to 

determine the stepover. PowerMILL calculates the stepover value to give 

a cusp height of the machining tolerance using the current tool, when 

machining a plane inclined at 45 . This is the worst case cusp height for 

any given tolerance. 

For more information see Linkage between stepover and cusp height (see 

page 124). 

Use separate shallow options - allows you to define a different 

stepover for the steep and shallow portions of the toolpath. Normally, the 

stepover is defined by the Stepover field on the left hand side of the 

dialog. If you select this option, then only the steep (or Constant Z) 

portion of the toolpath is defined by the Stepover field on the left hand 

side of the dialog. 

When 3D offsetting the bottom of a pocket, PowerMILL machines 

from outside, inwards. However, when machining the top of a boss 

(an area with no steep regions above it) PowerMILL machines from 

inside, outwards. 

Shallow

Shallow defines different spiral options, cut directions, and stepover 

values for the shallow and steep portions of the toolpath. The shallow 

portion of the toolpath is defined by the Stepover field on the left hand 

side of the dialog. 

This page is only available if you select Use separate shallow 
options on the main page. 
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Spiral - produces a spiral path between two consecutive closed contours. 

This minimises the number of lifts of the tool and maximises cutting time 

while maintaining more constant load conditions and deflections on the 

tool.

It converts this: 

to this: 

Cut direction - determines the milling strategy. 

Climb - creates toolpaths using only climb milling. 

Conventional - creates toolpaths using only conventional or 

'upcut' milling. 

Any - creates toolpaths using both conventional and climb milling, 

as appropriate. This minimises the tool lifts and tool travel.  

Use separate shallow stepover - allows you to define a different 

stepover for the steep and shallow portions of the toolpath.  
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Stepover - the distance between successive machining passes. This is 

the Stepover for the shallow portions of the toolpath. The Stepover for 

the steep portions is defined on the main page (see page 92). 

 Shows the 3D Offset toolpath stepover in the shallow areas. 

 Shows the Constant Z toolpath stepover in the steep areas. 

Raster

Raster defines the raster options for the toolpath. 

This page is only available if you select a Type of Raster on the 

main page. 

Wall clearance - used to prevent raster spans at the bottom of a steep 

area from hitting that steep area. This prevents dwell marks on the steep 

areas. 
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Wall clearance - 0

Wall clearance - 2

Auto angle - PowerMILL automatically calculates the most appropriate 

angle for each shallow region. 
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Auto angle - deselected

Auto angle - selected 

Angle - defines the angle of passes relative to the X axis. 

Angle - 0
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Angle - 30

Automatic verification 

Automatic verification enables verification of toolpaths on creation. 
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Head clearance - represents the notional combined length of the tool 

tip, shank, and holder. The default value is set to 600 mm. This value can 

be set even if you do not define a shank or holder. If the height of the tool 

assembly is less than the Head clearance value, then an additional 

component is added internally to the tool assembly. This component has 

the same diameter as the uppermost item in the tool assembly (if 

Automatic collision checking is On), and a length such that the total 

tool assembly length specified is the same as the Head clearance value.

 - tool length 

 - shank length 

 - holder length 

 - minimum head clearance value 

 - if a head clearance value is greater than the tool assembly height, 

then an additional component is added. 

! The height of the tool assembly is just the cutter ( ) if 

Automatic collision checking is Off and is the tip, shank, and 

holder ( ) if Automatic collision checking is On.

! If you define a tool assembly which is longer than the Head
clearance value, then the Head clearance value is ignored. 

! For disc cutters, if a shank is defined, then additional components 

are added to give the total tool assembly a length equal to the 

Head clearance value. 

Automatic collision checking - controls collision checking of 

toolpaths during toolpath calculation. 
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When selected, the tool shank and holder are collision checked. The 

resulting toolpath only contains the non-colliding (safe) moves. This can 

lead to gaps in the toolpath.  

If unselected, the tool shank and holder are not collision checked.  

Collision checking using the Toolpath Verification dialog

will check against shank and holder regardless of this option. 

Shank clearance - represents a specified “safe” area around the tool 

shank which is taken into account when checking for collisions. 

Holder clearance - represents a specified “safe” area around the tool 

holder which is taken into account when checking for collisions. 
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 Holder clearance 

 Shank clearance 
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Corner Clearance - overview 
The new Corner Finishing strategy allows you to define a toolpath to 

remove material left in corners. The toolpath is generated such that the 

the rest material is removed in successive stages, using horizontal and 

vertical stitch movements, or along passes. 

Steep regions are machined with horizontal stitches by default. You can 

select Along passes to machine steep regions. 
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Horizontal stitches 

 - Steep stepover  

 - Steep depth of cut 

 - Steep final depth of cut 
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Along passes 

 - Steep stepover  

 - Steep depth of cut 

 - Steep final depth of cut 

For comparison, the horizontal stitch toolpath is shown in 

grey.

Shallow regions are machined with along passes by default. You can 

select Vertical stitches to machine shallow regions. 
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Along passes 

 - Shallow stepover 

 - Shallow depth of cut 

 - Shallow final depth of cut 
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Vertical stitches 

 - Shallow stepover 

 - Shallow depth of cut 

 - Shallow final depth of cut 
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There are several tabs associated with Corner clearance:

! Corner clearance (see page 115)- the main page used to define a 

corner clearance toolpath. 

! Corner detection (see page 118) - determines the location of the 

toolpath.

! Finishing (see page 119) - allows you to specify a final depth of 

cut value which is different from the normal depth of cut value. 

! High speed (see page 119) - enables arc fitting in internal corners 

to eliminate sudden changes in tool direction. This is essential for 

high speed machining. 



PowerMILL 2010 What's New Toolpath generation • 115

! Stock management (see page 121) - enables you to use a stock 

model and gives you options to specify material thickness. 

! Automatic verification (see page 105) - enables automatic 

verification of toolpaths on creation. 

The remaining tabs are common toolpath creation controls. 

Corner clearance 

Corner clearance is used to remove material left in corners, in 

successive stages. 

Segment type - selects the type of machining. 

! Horizontal stitches - is the default setting for steep region 

machining.  

! Vertical stitches - can be used for shallow region machining. 

! Along passes - is the default setting for shallow regions. 

Along passes can be used on both steep and shallow regions. 
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Stepover - the distance between successive machining stitches or 

passes.

Depth of cut - the thickness of material to be removed by each cut. 

Tolerance - determines how accurately the toolpath follows the 

contours defined by the model. 

Cut direction - determines the milling strategy. 

Climb - creates toolpaths using only climb milling. 

Conventional - creates toolpaths using only conventional or 

'upcut' milling. 

Any - creates toolpaths using both conventional and climb milling, 

as appropriate. This minimises the tool lifts and tool travel.  

Thickness - specifies the amount of material to be left on the part, 

within tolerance. 

 - clicking the Thickness  button changes the 

Thickness field to Radial thickness  and the Axial thickness

 field appears. Now you can specify separate Radial and Axial

thickness values .

 Thickness - applies the thickness as an offset to the tool in all 

directions: 
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 Radial thickness - applies the thickness as an offset to the tool 

radially. This can be useful where you want to leave material on 

vertical walls. 

 Axial thickness - applies the thickness as an offset to the tool, 

in the tool axis direction only. This controls the tip position of the tool 

used for machining, relative to the tool defined in PowerMILL. 

Variable thickness (that is to say, separate Radial and Axial
thickness values) is particularly useful for orthogonal parts. It is 

possible to use variable thickness on sloping walled parts, although it 

is more difficult to predict the results. 

In thin-walled aerospace parts, you may want the area clearance 

toolpath to finish the floor of the pocket, but to leave material on the 

thin vertical walls. In this case, specify a positive Radial thickness 
value and an Axial thickness of 0:

 - Radial thickness 
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Alternatively, you can also use this method to finish the steep side 

walls and leave material on the bottom. In this case, specify a Radial
thickness of 0 and a positive Axial thickness value: 

 - Axial thickness 

Typically, it is used on flat-bottomed parts with pockets. 

To avoid too much material being removed, Thickness should be 

greater than Tolerance.

 - displays the Component thickness dialog, which allows you to 

specify the thicknesses of the different surfaces. 

Corner detection 

Corner detection determines the location of the toolpath. 

Reference Tool - specifies the tool used to create the previous toolpath. 

Either define the tool geometry here or select it from the tool list. 

Corner radius (tool diameter units) - the value for arc fitting used 

on the previous toolpath. 

Overlap - specifies the amount by which the toolpath extends beyond 

the borders of the un-machined region. 
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Finishing

Finishing allows you to specify a final depth of cut value which is 

different from the normal depth of cut value. 

Corner finishing - enables you to specify a final depth of cut. 

Final depth of cut - specifies the final depth of cut value. 

High speed 

High speed enables arc creation in all internal corners of a toolpath, 

using the Radius specified. 

This example looks at a constant Z toolpath, but the principles are the 

same for all toolpaths. 
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When Arc fit corners is deselected, sharpening is carried out on all 

internal corners.  

When Arc fit corners is selected for the same example, arcs are created 

in all internal corners, using the Radius specified: 

Arc fitting is of particular importance when high speed machining as it 

eliminates sudden changes in tool direction. 

Radius (Tool Diameter Units) - defines the radius used if you select 

Arc fit corners. The radius is defined as a proportion of the tool 

diameter. The default value is 0.05. So, if you have a tool of diameter 10 

mm (radius 5 mm), then the arc radius will be 0.5 mm. 
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The Radius slider can have a value between 0 and 0.2. 

Stock management 

Stock management enables you to use a stock model and lets you 

specify material thickness options. 

Consider remaining stock - enable this option to select a stock model 

and associated options. 

Stock model - select the stock model from the list. 

Detect material thicker than - the calculation ignores rest material 

thinner than the threshold specified here. This helps to avoid thin regions 

being rest machined, where the benefit of a second cut is negligible. 

These thin regions can be caused by cusps from the previous toolpath. 

Excess material allowance - the amount of excess stock material to 

be considered. 

The toolpath expects the stock to be close to what would be left after 

machining with the reference tool. If there is any excess material to be 

considered over and above this, specify the value here. 
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Allow tool centre outside block 
Finishing strategies now have the option to allow the tool centre to go 

outside the block. In previous versions, this option was only available for 

area clearance strategies. 

The advantage of this is that you can machine from outside the block and 

you no longer need to make the block larger than the part in order to get 

the tool to move outside the part. The block can now represent the stock. 

In 5-axis, the criteria is that any part of the tool should be inside the 

block. Again, this allows machining bits of the part very close to the edge 

of the block from the outside. 

This is available on the Limit page of the strategy dialogs. 

Block - determines whether the tool is allowed outside the block. 

If you start with this model and block: 
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Selecting  gives: 

Selecting  gives: 
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 - allows the tool outside the confines of the block. This option 

should always be selected if the block has been defined to represent the 

actual size of stock you are machining. This will maximise the removal of 

material during area clearance and avoid plunge or ramp entries wherever 

possible. 

 - the tool tip is contained within the block. 

Linkage between stepover and cusp 
height

The cusp height and stepover are now linked on finishing dialogs. 

Entering a Stepover value automatically calculates the Cusp height

. Similarly, entering a Cusp height  automatically calculates the 

Stepover value. 
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To see this effect, see the main page of any finishing strategy that uses a 

Stepover, such as Optimised constant Z finishing.

Click  to automatically define the stepover from the tool geometry. 

The extra border round the Cusp height field  shows that 

it has been calculated automatically, and not entered by you. 

Change the Stepover value to 5.

You can see that  changes to  as the value was manually edited 

and the Cusp height  value has changed. 

Change the Cusp height value to 3.
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Smoothing 3D offsets 
There is a new option of Smoothing on the 3D offset finishing dialog. 

This smooths offsets of toolpath segments over the model. It smooths 

sharp corners, blends angular offsets and maintains the feed rate 

momentum. This blending gives a result similar to raceline machining. 

Smoothing selected: 

Smoothing deselected: 
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Constant Z improvements 
There are a couple of new options on the Constant Z finishing dialog: 

! Undercut - allows you to machine areas with undercuts. This 

works for lollipop (tipped disc) tools. 

If you start with this model: 
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Undercut - selected:

Undercut - deselected:
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 - areas not fully machined. 

! If a vertical tool axis is used, undercuts work with ball nosed, 

tapered spherical and tipped disc tools. 

! If the tool axis is not vertical then undercuts work with ball 

nosed, tapered spherical and spherical tipped disc tools.  

Not all tipped disc tools work with a non-vertical axis, only 

those with a (hemi)spherical end, (where diameter=2*tip 

radius).

When undercuts is selected, the Additional stock and 

Machine down to flats options are greyed out. The Unsafe 

segment removal page is also unavailable. 

! Machine down to flats (see page 129) allows you to machine 

exactly on the flat areas of the model.  

! High speed (see page 130) enables arc creation in all internal 

corners of a toolpath, using the Radius specified. 

! Unsafe segment removal (see page 132) prevents machining of 

small areas, especially in small pockets. 

This is the same functionality that is available on area clearance 

toolpaths.  

Machine down to flats 

Machine down to flats adds a constant Z slice on flat surfaces at the 

bottom of steep features. This option eliminates the need to create a 

separate pencil toolpath at the flat height. 
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Machine down to flats selected: 

 - flat surface 

Machine down to flats deselected: 

High speed 
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When Arc fit corners is deselected, sharpening is carried out on all 

internal corners.  

When Arc fit corners is selected for the same example, arcs are created 

in all internal corners, using the Radius specified: 

Arc fitting is of particular importance when high speed machining as it 

eliminates sudden changes in tool direction. 
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Unsafe segment removal 

There is a new option of Unsafe segment removal which has its own 

page on the Constant Z finishing dialog. This removes small toolpath 

segments to prevent damaging tools with a non-cutting centre.  

Unsafe segment removal removes small toolpath segments to prevent 

tool damage when using non-centre cutting tools. When machining down 

into small pockets, removing small segments stops the central, 

non-cutting underside of the tool from hitting non-machinable material. 

Remove segments smaller than threshold - removes segments 

that are smaller than the Threshold value, unless they surround a boss. 

Remove segment smaller than threshold - deselected: 
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Remove segment smaller than threshold - selected: 

 - areas where segments have been removed as these segments are 

smaller than the Threshold value. 

Threshold (tool diameter units) - is the size against which all 

segments are compared. The higher the threshold value, the more 

segments are removed. 

The minimum suggested threshold value is derived by dividing the 

non-cutting diameter by the full tool diameter. Values smaller than 

this will not remove all unsafe segments. A value of 1 will always 

remove all unsafe segments, but may also remove some safe 

segments.
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 - Segment length (Ls) 

 - Pocket length (Lp) 

 - Tool diameter (D) 

 - Non-cutting tool diameter (d) 

This example uses a constant Z toolpath. 

Threshold (tool diameter units) - 1.5:

Threshold (tool diameter units) - 0.7:
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Only remove segments from enclosed areas - only removes 

segments in areas enclosed by material.

Remove segments smaller than threshold - deselected: 

Remove segments smaller than threshold - selected 

Only remove segments from enclosed areas - deselected: 

Remove segments smaller than threshold - selected 



136 • Toolpath generation PowerMILL 2010 What's New

Only remove segments from enclosed areas - selected: 

 - areas where segments are removed as these segments are smaller 

than the Threshold value. 

 - areas where segments are not removed as these segments are not in 

an enclosed area even though they are smaller than the Threshold value. 

View Toolpath by Z height 

Use the View Toolpath by Z height button on the Toolpath
toolbar to view a toolpath isolated at a particular Z height. This is helpful 

when viewing any Z height dependent toolpath. For example, toolpaths 

created using an area clearance, constant Z, or flat finishing strategy. 

The Z height viewing options are not available for other types of 

toolpaths.
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Viewing a toolpath without isolating 
a Z height level 

Viewing a toolpath at an 
isolated Z height level 

Even though you are viewing a particular isolated level in the 

toolpath, any changes you make at a Z height will be applied to the 

toolpath as a whole. 

To view an individual Z height slice of a toolpath, with the toolpath 

activated, click  to bring up the Z Heights dialog, click through the Z
Height list to examine the toolpath segments at the particular Z height. 
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Number - divides the block equally into the defined number 

of Z Heights, the lowest of which will be at the bottom of the 

block.

Stepdown - creates a Z Height at the top of the block and then 

steps down a defined height in Z. The final Z Height will be at the 

bottom of the block.  

Value - adds in additional Z Heights at a specified height. 

Intermediate - adds in additional Z Heights between existing 

ones.

Flat - identifies flat areas of the model and creates Z Heights 

on these areas. 

Reference Z - enter a Z value to view the toolpath segment nearest to 

the entered value. 

Pick a Z height from the model using the mouse - click this 

button to select and set a reference Z from a particular feature of the 

model. 

Flats only - select this option to view the part of the toolpath associated 

with flat regions of the model. 

Z - the current Z height. 

 - the difference between the current Z height and the reference Z. 

To simulate tool movements at a particular Z height, right-click on the 

toolpath segment that you want to simulate, and select Toolpath > 
Simulate from Nearest Point.

You can also right-click on a toolpath and select the View Picked 
Z Height option to access the Z Heights dialog. 
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Viewing toolpaths by Z height 

This is a simple example to demonstrate how to use the View Toolpath 
by Z height button and the Z Heights dialog. This example uses the 

flats.dgk in the Examples folder. 

1. Define a Block around the model. 

2. Create a Model Area Clearance strategy, and: 

a. Select Style as Offset all.

b. Enter a Stepover value of 5.0.

c. Create an end mill tool with a Diameter of 5.0.

d. Click Calculate to create the toolpath. 

The toolpath is now calculated for the model. 
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3. On the Toolpath toolbar, click  to display the Z Heights
dialog. The Z heights available in the toolpath are listed in the Z
Height list. 

Click through the list to view the toolpath segment at a 

particular Z height. 
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You can also: 

! Enter a Reference Z - to view the toolpath segment nearest to 

the entered value. 

! Use  to pick a Z height from the model to use as the 

reference Z. 

! Select Flats only - to view the toolpaths segments associated 

with only flat regions of the model. 

If you select a segment and click , the Z height view will start on 

the selected Z height. 
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Surface finishing improvements 
Surface finishing has a new option of Degouge tolerance.

Degouge tolerance - the maximum distance, normal to the surface, 

that the toolpath can move to find a safe position. If gouges greater than 

this value are detected, then the tool is lifted axially to avoid the gouge. 

Flat machining improvements 
Flat machining now works on triangle models as well as surface models. 

Drilling improvements 
You can now create holes from the drilling dialog. You no longer have to 

create a feature set and then create the holes in the explorer. 

The options displayed depend on the Use option selected. 
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 - the feature set in which the holes are created. 
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Use - determines how the holes are recognised. 

Points - creates holes from points in the pattern. These points define the 

centre of the hole. 

Circles - creates holes from circles in the model. The Diameter field is 

greyed out since the circles define this for you. 

Model - creates holes which have been fully defined in the surface model 

as a single surface with a defined top and bottom. 

Pairs - creates holes from pairs of circles in the model. 

Curves - creates holes from any curve in the model that will flatten into 

a circle in the given workplane. 

Lines - creates holes from lines in the pattern. These lines define the top, 

bottom, and axis of a hole. 

Plunges - creates holes from the plunge moves of the active toolpath. 

Normals - creates holes from the contact normal moves of the active 

toolpath.

Hole creation allows you to select how and which holes are created.  

Multi-axis - when selected, all the holes are placed in one feature set (so 

PowerMILL assumes that you can handle multi-axis drilling). When 

deselected, the holes are sorted into feature sets by workplane (so 

PowerMILL assumes that you can handle 3+2-axis drilling). 

Starting with the RetainerPlate.dgk model, an active workplane, and 

the whole model selected: 
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Multi-axis selected: 

Multi-axis deselected: 

Compound holes - when selected, one compound hole containing 

several components is created. When deselected, several individual holes 

are created (superimposed on each other). 

You can see the difference between the representation of a compound 

hole and an individual hole in the explorer. 

For more information, see Compound Holes.

Create from partial holes - enables the creation of holes from a model 

that has poorly or incompletely defined holes. For example, PowerMILL 

will create a hole from a pair of arcs. 

This option should always be used as a last resort as it may find 

many unwanted (or unexpected) holes. 

Active workplane - only creates holes whose Z axis aligns with the Z 

axis of the active workplane. 
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Starting with the RetainerPlate.dgk model, an active workplane, and 

the whole model selected: 

Active workplane only selected: 

Active workplane deselected: 

Tolerance - the distance below which two end points are considered 

coincident.

Define top by - the height of the top of the hole. 

Absolute - defines the Z height at the top of the feature as an asolute Z 

height.
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Height from Bottom - defines the top as a distance from the bottom of 

the feature. 

Maximum Curve Z - all features use a curve (bits of model or pattern) 

as the input data . These curves have a minimum and a maximum z value 

which can be used for feature definition. This input method is also very 

useful for hole definition where you have a set of Z positions that 

represent the top or bottom of the hole. So this is the maximum Z height 

of the selected curve to determine the top of the feature. 

Minimum Curve Z - this is the minimum Z height of the selected curve 

to determine the top of the feature 

Top of Block - defines the top as the height of the top of the block. 

Line Start - defines the top as the start of the line. This option is only 

available if you have a Use of Lines.

- specifies the value of the height of the top of the feature. 

Define bottom by - the height of the bottom of the hole. 

Absolute - defines the Z height at the bottom of the feature. 

Depth from Top - defines the bottom as a distance from the top of the 

feature.

Maximum Curve Z - this is the maximum Z height of the selected 

curve to determine the bottom of the feature. 

Minimum Curve Z - this is the minimum Z height of the selected curve 

to determine the bottom of the feature. 

Bottom of Block - defines the bottom as the height of the bottom of the 

block.

Line End - defines the top as the end of the line. This option is only 

available if you have a Use of Lines.

- specifies the value of the height of the bottom of the 

feature.

 - diameter of the hole. 
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Draft angle - creates a hole with a draft angle. 

Create features - creates a new feature, in the active feature set, with 

the parameters defined here.  

You must select the model, or part of the model,where you want to 

create holes. 

The options displayed depend on the Use option selected. 

These options are the same as those available from the Create tab on the 

Feature dialog (available from the Feature sets right click menu). 
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Parallel processing 
As with PowerMILL 10.0, one of the most important, but least visible 

improvements in PowerMILL 2010 is the use of parallel processing.  

In PowerMILL 2010 parallel processing has been implemented on: 

! Basic 3-axis strategies including: 

! Corner finishing strategies, especially corner pencil finishing 

which calculates twice as fast on a quad core machine in 

PowerMILL 2010 than it did in PowerMILL 10.0. 

! Area clearance, especially roughing. 

! Constant Z, especially when using low tolerances. 

! 3D offset, especially when using low tolerances. 

! Some of the new functionality including: 

! Tool holder profile. 

! Smooth 3D offsets. 

! Corner clearance. 

! Tool axis smoothing in: 

! 3D offset. 

! Constant Z. 

! Steep and shallow. 

Parallel processing works automatically if your computer is suitable, you 

don't need to do anything to activate it. 
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When verification splits a toolpath, the leads and links are preserved 

where appropriate, on the resulting toolpaths. This includes any leads and 

links that are defined through selective editing. 

Simulation can now synchronise the movement of two axes of a robot. 

This enables you to keep one arm of the robot stationary whilst jogging a 

different arm. 

ViewMill now allows a negative overhang. 

The Table attach point at the top of an .mtd file now defines the 

position of the PowerMILL origin. This is useful when machine tools are 

defined with an origin somewhere on the floor at the base of the machine. 

When the machine is loaded into PowerMILL, the PowerMILL origin 

then corresponds to the machine tool origin, and so the model, block.... 

are located at an inappropriate position on the machine. To correct this, so 

that the PowerMILL origin is located on the table of the machine tool, 

specify a Table attach point to locate the PowerMILL origin. You can 

still use a workplane to reorientate the position, if required. 

This is backward compatible with existing mtd files since the table 

attachment point is: 

! not defined, in which case it defaults to 0 0 0. 

! defined to be 0 0 0, in which case the PowerMILL origin is at the 

machine tool origin.  

This functionality is especially useful for robots where the origin in 

the cell may be somewhere unrelated to the machine. 

Toolpath verification 
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This topic has not been fully documented yet. 

Toolpath output 
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Open and Save dialogs 
The project Open and Save dialogs now have customisable buttons. 

These are very similar to the File Open and Save dialogs, which 

themselves have been updated. 

 - changes the directory to the current Project directory.  

 - changes the directory to the Examples directory. This is defined 

using Tools > Customise Paths.

 - changes the directory to the user defined directory. This is 

defined using Tools > Customise Paths.

User interface 
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 - changes the directory to the user defined directory. This is 

defined using Tools > Customise Paths.

 - changes the directory to the My Documents directory. 

Entity lists show folder structure 
Entities in drop down lists, now show the same folder structure and icons 

as in the explorer. 

Looking at these toolpaths in the explorer: 
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In PowerMILL 2010, the active toolpath list on the Toolpath toolbar 

displays the folder structure and icons, which makes it far easier to find 

the required toolpath: 

In PowerMILL 10.0, the active toolpath list on the Toolpath toolbar 

doesn't display the folder structure or icons, it displays a flat list which 

makes it harder to find the required toolpath: 
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When you start PowerMILL 2010 for the first time, you are asked if you 

want to upgrade to the new tool database. Clicking Yes upgrades to the 

new version and creates a backup of your old database. This enables your 

existing database to use all the latest database functionality, such as the 

new tool holder functionality (see page 19). 

General
enhancements
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Custom toolbars 
Using a custom toolbar, you can have the menu options, toolbar buttons, 

commands, and macros that you use frequently, available at a single 

location.

You do not need to remove these from an existing toolbar or menu, you 

can duplicate them on your custom toolbar and they will work in exactly 

the same way as the original menu or button. 

Like a normal toolbar, custom toolbars can be moved around the screen to 

have them in the place that you find most convenient. 

To create a custom toolbar, from the PowerMILL main menu, select 

View > Toolbar > Custom > Customise....
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Use the Customise toolbar dialog to create or modify a custom toolbar. 

You can create up to four custom toolbars. By default, custom 

toolbars are named Custom1, Custom2, and so on. You can rename 

them in the Customise dialog. 

To select a custom toolbar, from the PowerMILL main menu, select 

View > Toolbar > Custom and select the custom toolbar. 

Creating and modifying a custom toolbar 

To create a custom toolbar: 

1. From the main PowerMILL menu, select View > Toolbar > 
Custom > Customise.... The Customise toolbar dialog 

appears.

2. In the Toolbar list, enter the name of your toolbar or select a 

toolbar from the list. 

3. In the Type list, select: 

! Menu (see page 160) - to select items from the PowerMILL 

main menu. 

! Toolbar (see page 160) - to select items from various 

PowerMILL toolbars. 

! Command (see page 161) - to add a PowerMILL command to 

the custom toolbar. 

! Macro (see page 161) - to select a macro to be represented as a 

button on the toolbar. 
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To further modify the toolbar, click: 

! Add Separator - if you want to add a separator between the 

buttons.

! Add Gap - if you want to add spaces between your toolbar 

buttons.

! Clear All - to remove all buttons from the custom toolbar. 

! To remove individual buttons, select the button you want to 

remove and click .

! To change the order of the buttons, select the button you want to 

rearrange and click  or  to move it. 

! To modify the button text or image, click  to open the 

Customise Button dialog and make modifications. 
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To modify buttons for Menu and Toolbar:

! Select the Text option and enter a Description for the button 

name; 

! or select the Picture option and choose an icon from the list to 

represent your button; 

! or click  to select a custom image for your button. 

When you select a Command or a Macro button to modify, the 

Customise Button dialog enables you to make modifications to the 

original command or macro. 

Custom Command Custom Macro 
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Customise Toolbar - Menu 

To add a menu to the custom toolbar: 

a. Select Menu from the Type list. 

b. Select the menu you want from the Select menu list, for 

example, File.

c. Select a sub menu from the Item list, for example, Close
Project.

d. Click Add.

A button with the name of the menu you selected is added to the 

custom toolbar. 

Customise Toolbar - Toolbar 

To add a button from any PowerMILL toolbar to the custom 

toolbar:

a. Select Toolbar from the Type list. 

b. Select the toolbar you want from the Select toolbar list, for 

example, Main.

c. Select a toolbar item from the Item list, for example, .
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d. Click Add.

The toolbar button you selected is added to the custom toolbar. 

You can also click and drag the  button and drop it onto 

the button that you want to add to the custom toolbar. 

Customise Toolbar - Command 

To add a PowerMILL command to a custom toolbar: 

a. Select Command from the Type list. 

b. In Command, enter the PowerMILL command, for example, 

CREATE TOOL ; ENDMILL FORM TOOL.

c. Enter a name for the command button in Description, for 

example, Create endmill tool.

d. Click Add.

The command button you created is added to the custom toolbar as 

a button. 

Customise Toolbar - Macro 

To add a PowerMILL macro to a custom toolbar: 

a. Select Macro from the Type list. 
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b. In Macro, enter the path or click  and select the macro file. 

c. Enter a name for the macro button in Description.

d. Click Add.

The macro button you created is added to the custom toolbar as a 

button.

Tools > Options system parameters 
The user definable values available under Tools > Options are system 

parameters. These parameters can be used to create expressions; and the 

fields which allow user definable values retain expressions for further 

use.

In this example, the Closure Tolerance is defined as the expression 

Current.Tolerance*5, and the expression is viewed on the Expression
Editing toolbar. 

The fields which contain retained expressions are shown as .

Click inside the field to view the expressions (see page 163) on the 

Expression Editing toolbar. 
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Expression Editor 
Expression Editor lets you create and calculate expressions in 

PowerMILL.

If the Expression Editor is not displayed, from the PowerMILL 

main menu, select View > Toolbar > Expression Editor to
display it. 

By default, the Expression Editor displays the values in the 

PowerMILL fields that is currently selected. 

 - the name and value of the currently selected 

field is displayed on the toolbar. If the field contains an expression, it is 

displayed.

Evaluate expression - toggles between displaying calculated 

value and expression. 

 Undo - undo last edit. 

 Redo - redo last edit. 

Accept - accept expression or value after evaluation. If you click 

 when an expression is displayed, the expression is copied into the 

field; when a value is displayed, only the value is copied into the field. 

Cancel - cancels all edits. This cancels any changes you made and 

reverts the field to what it was before you started editing. 

To activate the Expression Editor to perform calculations and evaluate 

expressions, click inside a PowerMILL field so that the field value is 

displayed in the toolbar, and then click the field inside the Expression
Editor. The field changes colour to indicate it is selected. 

You can also right-click inside a field and select Expression
Editor from the context menu to activate it. 

The expressions can be as simple as tool.diameter/2 or it can be as 

complex as 

cos(45)*sqrt(((tool.diameter/2)^2)-(((tool.diameter/2)-tolerance)^2))*2.
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The toolbar calculates parameter values based on the context it is 

used. For example, if you enter tolerance when the value is checked 

from the boundary dialog, it is calculated as boundary tolerance 

and when checked from the toolpath dialog, it is calculated as 

toolpath tolerance. 

You can create expressions by typing parameters into the Expression
Editor or by selecting a field in a dialog. The Expression Editor 
suggests parameters which start with the same characters you have 

entered. For example, typing Th into the toolbar lists all parameters 

available which start with the word Th, such as, Thickness,
ThicknessSets, ThicknessSetValues, and so on. 

The parameter names which have a "." after them require an additional 

value to complete it. When you select the parameter name which contains 

a ".", a list which contains the possible values to create the complete 

parameter, is displayed. 

The list of parameters to construct expressions in PowerMILL is 

available from: 

Help > Parameters > Reference - contains detailed 

documentation of expression parameters available in 

PowerMILL.

Help > Parameters > Summary - contains a summary of 

expression parameters available in PowerMILL. 

When you have finished constructing the expression, click  to accept 

the expression into the field from where it was initially called. 
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When you click  the currently displayed entry is copied into a 

field.

So, if an expression is displayed, it is copied into the field and the 

field changes to  to indicate it contains a retained 

expression.

If a calculated value is displayed when you click , only the value 

is copied into the field and the expressions used to calculate the 

value is discarded. 

Using the Expression Editing toolbar 

This example demonstrates how to use the Expression Editing toolbar 

when working with retained expressions in the Model Area Clearance
strategy dialog. 

1. On the Main toolbar, click  to display the Strategy Selector
dialog.

2. From the 3D Area Clearance tab, select the Model Area 
Clearance toolpath strategy. 

3. In the Thickness field, enter the expression tolerance*4 and press 

Enter. The result is displayed in the Thickness field and the field 

appearance changes to indicate that it now contains an expression 

.

If any of the values cannot be zero, PowerMILL displays the 

value in the field as @error.

Click inside the Thickness field to view the expression in the 

Expression Editing toolbar. 

PowerMILL calculates and displays the Thickness value based 

on the tolerance and retains the expression to use in future 

calculations. 

If you make any changes to the Tolerance value, PowerMILL 

automatically recalculates the Thickness.

To make changes to the expression using the Expression 
Editing toolbar: 

1. Click inside the Thickness field to display the expression in the 

Expression Editing toolbar. 
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2. Click inside the Expression Editing tool bar to activate it. The 

Expression Editing toolbar appears green. 

3. Change the expression to tolerance*10.

To see the result of the calculation, click  to toggle 

between the result and the expression. 

4. Click  to accept the expression and copy it into Thickness
field.

If you want to copy just the result but not the expression into 

a field, click  to display the result and then click .

You can use imperial values in a metric project or metric values in 

an imperial project. For example, if the thickness of the toolpath is 

tolerance times 1/8 of an inch, you can enter tolerance*(1/8 in).

The list of parameters to construct expressions in PowerMILL is 

available from: 

Help > Parameters > Reference - contains detailed 

documentation of expression parameters available in 

PowerMILL.

Help > Parameters > Summary - contains a summary of 

expression parameters available in PowerMILL. 
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Status bar additons 
The Status bar has some extra options. 

The Position  button is new and the coordinates buttons were on the 

Curve Editor toolbar. 

Position - moves entities using typed coordinate input rather than 

using the cursor. This is a new option. 

 Relative/Absolute Coordinates - toggles between relative and 

absolute coordinates. 

Relative Coordinates - the entities are moved by the amount 

specified in .

Absolute Coordinates - the origin of the entities is moved 

to the coordinates specified in .

Coordinates - enter the coordinates here in the form x y z. 

For example, to move the origin by 10.4 in x, 25.6 in y, and 12.2 in z, 

enter 10.4 25.6 12.2.
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Smoothing - 3D offset finishing • 
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118

Index
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Detect material thicker than - 
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Editing an arc • 55 

Insert point - curve editor • 47 

Insert point in curve example • 51 

Line editor • 53 

Number points - curve editor • 47 
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Reverse selected curve • 44 

Select points • 50 
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editor • 47 
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Expression editing toolbar • 163 
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Holder profile - tool • 21 
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Interleaved constant Z toolapth • 92 

L
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Lean then lead • 8 
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Editing a line • 52 

Line editor • 53 

Line editor • 53 

Line menu • 62 
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Corner clearance • 109 

Flat machining • 142 
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Orientation vector - tool axis • 14 
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editor • 47 

Polar coordinates • 39 

Polyline menu • 67 

Position • 37 

Cartesiian coordinates • 38 

Polar coordinates • 39 

R
Raster - steep and shallow • 92, 102 

Angle - steep and shallow • 102 

Wall clearance - steep and shallow 

• 102 
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Save
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Select points • 50 
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Silhouette boundary • 73 
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Smoothing - 3D offset finishing • 126 

Smoothing - steep and shallow • 92 

Smoothing - tool axis • 10 
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Stock model - corner clearance • 121 

Stock models tool state menu • 78 

Strategy
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Automatic verification • 105 
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Flat machining • 142 
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Steep and shallow finishing • 90, 92 
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Toopath verification • 150 
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Workplane align • 29 

Workplane editor • 29 

Workplane editor toolbar • 29 
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Translate workplane • 29 

Undo last transform - workplane • 

29
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View toolpath by Z height • 136 


